
New features in data collection and beamline controls 

As of February 3, 2013 
General 
 
Hutch tab 
 
Sample tab: 
 
Screening tab/Sample automounter 

 Multiple (up to 20) consecutive images can be collected at each of the three 
possible angles. 

 Every time strategy results are recalculated in the Collect tab, the sample 
Spreadsheet in the screening tab is updated with new results. 

 Gripper is automatically sent to warm up when the expected data collection time 
exceeds the scheduled warm up time. 

 
Raster tab: 

 Multiple rastering sites, found in interactive mode, can be manually selected and 
passed to the Collect tab for further data collection. 

 Raster parameters are now also saved. 
 
Collect and Analysis tabs: 

 Automated data processing starts after specified (by staff) sweep of data is 
collected. At the completion of processing, new images are detected and 
processing starts again from the beginning. Processing results, which are also 
displayed in the Analysis tab, are overwritten each time processing is completed. 

 AIMLESS replaced SCALA as a default program for scaling and merging. 
SCALA can be selected from Options menu. 

 Every time strategy results are recalculated in the Collect tab, the sample 
spreadsheet in the Screening tab is updated with new results. 

 Helical mode selection added, making the setup more straightforward. 
 
Scan tab: 

  



New features in data collection and beamline controls 

As of October 5, 2012 
General 

 A control panel is implemented under Tools  Options 
 The CCD binning mode can be changed for screening (in control panel), rastering 

(in raster tab) and data collection (in control panel) between 72 μm and 144 μm 
size pixels 

 File and directory selection dialogs are improved 
 
Hutch tab 

 Beam alignment graphs are integrated in the hutch tab 
 
Sample tab: 

 Measured full beamsize is shown on Highres tab beam display options as Full 
Width at Half-Max. It is also saved in the experimental log file. 

 When main Sample tab or peel-out Sample tab window is resized, the video and 
diffraction image will resize accordingly. 

 
Screening tab 

 Diffraction-based centering is an option during screening 
 Beam size selection added to screening tab data collection parameters. 
 Time remaining till next warm-up is displayed below the warm-up button on 

screening tab. 
 New button added for popup window to show the sample status 

 
Raster tab: 

 Diffraction rastering can be done with still images 
 
Collect tab: 

 fast_dp was added as a default for data processing. 
 Data processing works for multiple sites from vector/raster data collection, vector 

collection with overlaps and inverse beam. Combined mtz file available in the 
processing directory. 

 Strategy and Data processing results are automatically saved to excel file. 
 
Scan tab: 

 Chooch results for edge scans are shown immediately after the scan finishes. 



New features in data collection and beamline controls 
As of June 4, 2012 

 
General  

 PSS panel and the search boxes have changed 
 Cancel option was added to the JBluIce startup screen 
 The file name and directory dialogs have changed 
 The ring light will turn on when images are being collected and will turn off when 

collection is completed 
 The “+” and “-“ buttons on the diffraction image viewer will display the “next” and 

“previous” images even if their numbers are not adjacent 
 From the Options pull-down menu, BEST or MOSFLM  can be selected for strategy 

 
Hutch tab 

 Beam optimization scans are displayed in the hutch tab as well 
 Pull-down arrows replaced the “A” buttons for stopping the motors. They will be 

replaced later with stop signs 
 
Screening tab 

 Has moved in front of the Collect tab 
 
Sample tab 

 Point-and-click works only with left click 
 Point and click move undo/redo menu option is added 

 
Raster tab: 

 Resolution limit selection is added to both Interactive and Auto rater tabs 
 In Auto mode, the search polygons can be set up automatically, or semi-

automatically to match the mounted loop 
 When the sample is unmounted, all raster-related information is deleted. This can 

be turned on or off from the menu option 
 Once rastering job starts, the “Start” button changes into “Resume” 
 Display option check boxes have been replaced by toggle buttons 
 Site centering buttons have been replaced by an option in the right click menu 
 Results from interactive raster runs can be added to the site list with right click 
 The site naming convention has changed. For example, AF3O2 would mean that 

the site came from Auto mode, fine-step raster job number 3, 2nd hit from the run 
in orthogonal plane. Right click on the site explains the site name 

 Collect runs can be created for specific raster sites from right-click menu 
 Multiple raster sites can be passed to the Collect tab by CTRL + right click 
 “A” is added to file name prefix in the Auto mode 
 Reliability of the Auto raster has been improved 
 Color map can be hidden in fluorescence raster 
 Fluorescence raster log is now written, similar to diffraction raster 
 Right click on the raster video allows the image to be saved, including the color 

maps and any other overlays 



 
Collect tab: 

 Raster sites can be added to the 0 tab 
 Beamstop distance has been removed from the Collect tab 
 Beam size is added to the Collect tab. The values are constrained to actual 

achievable size (5μm minimum and ± 3σ maximum) 
 When the sample is unmounted, all raster- and vector-related information is 

deleted. This feature can be turned on or off from the menu option 
 Raster or vector sites can be double-clicked to center 
 “Select all” and “Select none” buttons have been added to the vector site setup 
 The “Export strategy” button is added 
 Run sequence filename column resizes to display the whole file name 
 Diffraction images have finer contrast control at lower values  
 A frame collection may be delayed by 5 sec if the Keithley gain had to be 

changed 
 
Scan: 

 Fluorescence spectrum plot shows vertical bars based on the selected elements 
 Colors are slightly varied for multiple edges of the same element 
 “Show all” button will display the edges of all elemental listed under the plot 
 For overlapping edges, the nearby edge can be identified by hovering over with 

the mouse 
 Zooming in can be done by left click and drag 
 Right click offers menu of options, including zoom out, print etc 
 Chooch selection can be changed by dragging the corresponding bars and restored 

by clicking the “Defaults” button 
 
Analysis tab: 
This is a new tab. When auto-processing is selected in the Collect tab, data will be 
processed with XDS, POINTLESS, SCALA and TRUNCATE. Results will be displayed 
in this tab. Full log files can be displayed by clicking appropriate buttons 



New features in data collection and beamline controls 
As of Feb 6, 2012 

Raster tab: 
 In auto mode, the list of found and centered sites is passed to collect tab  

 
Collect tab: 

 Collect User Interface has been redesigned substantially 
 Collect tab diffraction viewer resizes to fill available space  
 Run sequence table can be expanded (and restored to original size) by clicking the 

double arrows 
 The Distance column in the run sequence table is replaced by Site Number 
 Strategy  

o All possible space groups in the Labelit solution are displayed in strategy 
window 

o By default only the space groups within highest point group are processed 
initially  

o Multiple space groups are processed in parallel to increase the speed 
o User can choose lower symmetry solution, JBluice will process and 

display strategy 
 Vector and Raster modes 

o Raster mode is added 
o Inverse beam geometry and multiple wavelength data collection now work 

with Vector and Raster modes 
o In Vector or Raster modes of data collection, given swath of data with 

inverse beam geometry or with multiple wavelengths is always measured 
from same sites 

 XDS 
o XDS checkbox is changed to a dropdown with three choices: None, 

Native, Anomalous 
o When a failure “INSUFFICIENT PERCENTAGE of spots” is 

encountered, XDS runs second time to complete the integration of data. 
o XDS can process Anomalous data 

 
Scan: 

 Chooch plot display is integrated into JBluIce.  PDF is still available by double-
clicking the plot. 

 Edge scan adaptive mode option is added to the menu 
 
Other: 

 There is a new GUI for starting the MAR software remotely 
 In the “Help” pull-down menu, Selecting “Crystallographic Software” opens the web 

browser and displays clickable list of available software 
 In the “Help” pull-down menu, Selecting “Video Tutorials” opens the web browser and 

displays clickable list of available tutorials 
 Operating system has been upgraded to CentOS 6.2 
 When external hard disk is mounted, the device name is assigned differently, not as 

/media/removable*# 



New features in data collection and beamline controls 
As of October 10, 2011 

 
 
Sample tab: 

 Beamsize selection moved to the top. 
 Pull-down menu for size display has disappeared. Selection can be made in High 

Res. View. 
 
Raster tab: 

 New parameter – “Corrected Bragg” is introduced to subtract erroneous “Bragg” 
spots   

 Results in auto-raster are more reliable with corrected Bragg spots  
 Macros are implemented for raster parameters 
 Diffraction raster speed has improved 
 Camera zoom can be changed during raster 
 “Loop Z” default has changed to 200. 
 In the raster heat map, the maximum value is always red.   

Collect tab: 
 A copy button copies the vector as well as the collect parameters to a new tab 
 Diffraction image updates can be stopped with the 'Stop' check box. The +/-

buttons can be used to browse through images. 
 Once a vector is set up, clicking "site check" and then "collect" will take the first 

frame for each site.  
 Vector sites can be manually centered using the site list.  
 The user is prompted to delete the vector when changing out of vector mode. 
 There is a selection button (XDSProc) for automated processing with XDS.   
 Strategy has a few changes: 

o Highest symmetry or P1 are selectable and strategy output is displayed 
according to this selection. 

o Strategy can be reported for native or anomalous data. For the latter, the 
results can be displayed for continuous or inverse beam modes. 

o Parameters that can be exported are in green. 
o All results can be saved in an Excel spreadsheet 
o All strategy results are now kept and can be reviewed as needed  

Other: 
 adxv follow mode does not freeze after a few hundred frames. 



New features in data collection and beamline controls 
As of June 4, 2011 

 
Raster tab: 

 Auto-raster  
o User enters rastering parameters and initial search area 
o JBluIce runs multiple grid searches to find promising sites in two orthogonal 

planes 
o Sites are individually centered for data collection and crystal size reported 

 “Position Sync” is now replaced by “Save Position”  
o Before a raster run starts, the sample position can be saved 
o Once a rastering run starts, user saved positions are cleared  

 
Collect tab: 

 Collect tab layout is slightly changed  
o "Single" mode disables vector collection for a given run 
o "Vector" mode enables setting the vector position and then the parameters 
o "Vector" options are moved to a separate sub-tab 

 Collect tab field interaction is improved  
o When setting up vector collection, only the "step size" and "number of sites" 

fields will significantly change the number and spacing of the sites. 
o It's recommended that "step size" and "number of sites" are set first, before 

any other parameters. 
 Strategy  

o In run 0, the user checks "strategy" and enters a second frame angle  
o Clicking "collect" takes two frames and processes them to generate a data 

collection strategy  
o The results are viewed on the strategy tab  
o Clicking "export" will create a new run tab with the generated strategy 

 The collect run 0 start angle field has a dropdown for +-90 degrees 
 
Screening tab: 

 Separate pop-up window with the name and status of the mounted sample 
 
Log tab: 

 Beam X,Y and Vector parameters are saved in the log file. 
 Log files are now written for images collected from the Screening tab 

 
Other: 

 Red Hat EL6 support 
 XDS input file is written for a data set containing more than 5 images. User can 

type xds or xds_par in the sub folder for processing. For now, unit cell parameters 
should be changed manually.



New features in data collection and beamline controls 

As of 02/06/11 
 
Sample tab: 

 High res camera tab has color-coded display of multiple beam sizes 

 The size of the displayed full beam can be manipulated by hosts 

 Guard Slit size display added to the sample tab 
 
Raster tab: 

 Polygon selection in raster tab, including multiple polygons 

 Old-style centered rectangle selection 

 Display of the beam size which will be used for rastering 

 Manual override of automatically selected cell and beam sizes 

 If the sample was mounted by the robot, default file, related to the current sample, is put 
in raster tab 

 Color-coded display of the results 

 Fluorescence rastering can be done in shuttle mode 

 Raster results now list absolute motor positions 
 
Collect tab: 

 Selection of the number of sites for data collection 

 Sites are now numbered in the vector collection 
 
Screening tab: 

 Rinse/Wash buttons added 
 Prefix override 
 Crystal ID-based default file name is put in the raster tab 

 
Log tab: 

 I0 and active beamstop intensity values are plotted as function of the frame number 
 
Other: 

 If autocentering fails, it gives a pop-up warning 

 adxv can update images during data collection  

  
 
 



New features in data collection and beamline controls  
As of 10/10/10 

 
General: 

 Blu-Ice is now JbluIce 
 Error messages are improved when requesting invalid parameters  

 
Hutch tab:  

 Resolution predictor takes into account 2θ and displays all resolution circles 
 
Sample tab:  

 Wash and rinse added in “Sample Tools”. 
 Annealing by CryoJet flow control and by moving the sample are together 
 Motions are disabled during diffraction image measurement 

 
Raster tab: 

 Rastering cell sizes are determined semi-automatically when the grid size is 
entered 

 Beam size is set automatically depending on the cell size 
 “Position sync” is added 
 Results are being written in a separate spreadsheet 
 Fluorescence rastering results are displayed same way as diffraction rastering 

 
Collect tab: 

 Resolution predictor displays resolution rings correctly when 2θ is not 0 
 Vector data collection feature is user-selectable 

 
Screening tab: 

 Spreadsheets with xlsx format are accepted 
 “Update” button is added 
 “Autoindex-Strategy” button added  
 Right click on the spreadsheet window brings up pull-down menu 
 Data collection parameters are independent from the Collect tab 
 Mouse-over displays brief explanations 
 Motions are disabled during diffraction image measurement 

 
Scan tab: 

 Center of the plot can be defined manually 
 
Robot dewar: 

 Improved dewars 


